
eZ-TOMAS  User’s Manual 
Software for Total Online Monitoring and Analysis Systems  
 

 

 
the smart approach to instrumentation ™ 

 
IOtech, Inc. 

25971 Cannon Road 
Cleveland, OH  44146-1833 

Phone: (440) 439-4091 
Fax: (440) 439-4093 

E-mail (sales): sales@iotech.com 
E-mail (post-sales): productsupport@iotech.com 

Internet: www.iotech.com 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

eZ-TOMAS User’s Manual 

Software for Total Online 
Monitoring and Analysis Systems 

 
p/n 1086-0923, rev 6.0 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

©  2001 . . . 2003 by IOtech, Inc 897196 Printed in the United States of America 



906996 

 



Table of Contents 

1  Introduction 

 897596 eZ-TOMAS, pg.  iii 

What is eZ-TOMAS …… 1-1 
Tips for Using eZ-TOMAS …… 1-1 
Starting eZ-TOMAS …… 1-2 
Connecting Signals …… 1-2 
The Order of Operation …… 1-3 
A Look at the Gauge Window …… 1-4 

2    Monitoring a Machine 

Creating a Project …… 2-1 
Configuring a Project …… 2-2 
Starting an Acquisition …… 2-4 
Viewing Spectral Bands …… 2-4 
Plotting Data …… 2-4 

Multiple Plots …… 2-4 
“Real-Time” Plot Controls …… 2-5 
“History Data” Plot Controls …… 2-6 

Viewing Reports …… 2-7 

 3   File Menu    [In Gauge Window] 

New Project …… 3-1 
Initialize Project …… 3-1 
Open Project …… 3-2 
Save As …… 3-2 
Erase History File …… 3-3 
Print …… 3-4 
Exit …… 3-4 

4  Edit Menu    [iIn Gauge Window] 

Setup …… 4-1 
Acquisition Tab …… 4-2 
Input Channels Tab …… 4-3 
Spectral Bands Tab …… 4-6 
     Tach Reference …… 4-5 
      Spectral Bands …… 4-5 
Storage Tab …… 4-7 

Limits …… 4-9 
Digital I/O …… 4-11 
Network …… 4-13 
Display Preferences …… 4-14 
Copy Window …… 4-14 
Load [or Remove] Graphic Picture …… 4-14 
Reset Peak Hold Values …… 4-14 

 
 

 

5  View Menu    [IIn Gauge Window] 
 

6   Plots . . . 

Introduction …… 6-1 
Changing Display Ranges & Scales …… 6-2  
“Real Time” Plot Controls …… 6-4 
“History Data” Plot Controls …… 6-4 
Channels …… 6-8 
Filtering Data …… 6-9 
Examples of Displays …… 6-10  

 
Time …… 6-10  

 
Spectrum …… 6-11  

 
Orbit …… 6-12 

 
Waterfall …… 6-13  

 
Bode …… 6-14  

 
Polar …… 6-15  

 
Strip Chart …… 6-16  

 
Shaft Centerline …… 6-17  

 

7   Reports Menu   [In Gauge Window] 

Statistical Report …… 7-1 
Alarm Log Report …… 7-4 
Snapshot Log ……. 7-5 
Configuration Setup [.txt File] …… 7-5 
 

8   Security Menu   [In Gauge Window] 

 

Appendix    A – Using Function Keys 

 

Appendix     B – Relationship of Terms



eZ-TOMAS, pg.  iv 897596  

 

 



Introduction 1 
 

What is eZ-TOMAS ? …… 1-1 
Tips for Using eZ-TOMAS …… 1-1 
Starting eZ-TOMAS …… 1-2 
Connecting Signals …… 1-2 
The Order of Operation …… 1-3 
A Look at the Guage Window …… 1-4 
 

 

Reference Note: 
Depending on whether your data acquisition device is a ZonicBook or a WaveBook, refer to 
the ZonicBook Getting Started User’s Manual (p/n 1086-0901) or to the WaveBook User’s 
Manual (p/n 489-0901) in regard to hardware setup. 

 

What is eZ-TOMAS? 
eZ-TOMAS (Total Online Monitoring and Analysis Software) is designed to collect vibration and process 
data from rotating machinery. 

eZ-TOMAS can simultaneously monitor, acquire, store, and display data from the ZonicBook FFT analyzer 
or from a WaveBook system.  The later can include a WBK14 Dynamic Signal Input Module or a WBK18 
Dynamic Signal Conditioning Module. 

The signals to be acquired are typically associated with a specific machine train.  The analog inputs can be 
any combination of Proximity, Velocity, Accelerometer, Tach, or DC proportional voltage signal.  Up to 
three tachometer signals are supported. 

 

Tips for Using eZ-TOMAS 
The following suggestions should make your use of eZ-TOMAS more efficient. 

1. For ZonicBook only: Make sure your ZonicBook’s Dip Switches are configured correctly. 
Typically:  Single Ended, AC coupled, and ICP ON.     

2. For ZonicBook or WaveBook:  Use a standard channel location convention.  
Typically:  A single Tach is used at channel 8. 
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Starting eZ-TOMAS 
To run eZ-TOMAS, double-click the eZ-TOMAS icon or use your Windows desktop 
Start button to navigate to the program file. 

The first time you start eZ-TOMAS you will be prompted for your name, your 
company name, and a password.  This password is the software key that will activate 
eZ-TOMAS for every day operations.   

Registration Form
 

If you are loading your software from a CD the password accompanies the CD.  If you downloaded your 
software from the website, your password will be e-mailed to you within one business day. 

You will next be prompted to set up your project’s security password.  When you click the <Save> button 
the Password Confirm window opens.  Retype your security password and click the <Confirm> button.  

After your password is accepted, you are returned to the Main window. 

 

Connecting Signals 

 

ZonicBook Users 
Connect the analog signals to the ZonicBook’s BNC inputs. Typically, proximity and DC proportional 
signals should be DC coupled; and Accelerometer, Velocity, and Tach signals should be AC coupled. 

Prox: SE(single ended) DC Coupled ICP off 
Accel/Vel: SE AC Coupled ICP  on 
Tach: SE AC Coupled ICP off 

Note that these settings are made via ZonicBook’s DIP switch. 
 

 

Reference Note: 
If necessary, refer to the ZonicBook Getting Started User’s Manual (p/n 1086-0901) for 
information regarding the following: 

• Software Installation 
• System Requirements 
• Hardware Setup   
• Driver Installation 

 

 

WaveBook Users 
Connect the analog signals to the WBK14 BNC channel input connectors, or to the WBK18 BNC channel 
input connectors.  Unlike the ZonicBook, the WBK modules require no hardware configuration. 

 

Reference Note: 
Information regarding WBK14 and WBK18 modules can be found in the WBK Options 
Manual (p/n 489-0902).  For detailed WaveBook information refer to the WaveBook User’s 
Manual (p/n 489-0901). 
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The Order of Operation 
 

Start eZ-TOMAS 
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A Look at the Gauge Window 
The main window of the GUI (graphical user interface) includes a set of virtual gauges, one gauge per input 
channel.  The set of gauges can make use of any one of 10 spectral bands, as indicated in the following 
table.  eZ-TOMAS can interactively display data in a variety of formats, including:  Spectrum, Orbit, Polar, 
Time, Bode, Cascade/Waterfall, Strip Chart, and Shaft Centerline. 

 

 

 

1-4 
 
Instrument 
(Gauge) Panel
 
 
 
 
 
 

 

 

Acquisition 
Panel 
 

 

The data acquir
files. This allow
data is stored ac

Acquisition, ins
are stored over 

 

 
Limit Check     Digital I/O    Data Storage      Options        Network
Gauge Window 

ed by eZ-TOMAS and the supporting configuration information are stored in user-defined 
s a single eZ-TOMAS system to be used with several different machines.  The acquired 
cording to user-defined event changes, e.g., time, overall, and rotating speed.   

trumentation, and storage configuration parameters are also definable.  These parameters 
time.  Configuration changes do not invalidate previously acquired data. 
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Instrument (Gauge) Panel 
The ten band types are listed in the following table.  You can define the parameters of the lower six bands 
in the Setup Configuration window.  To access the window, open the Edit pull-down menu and select 
Setup.  From the Setup Configuration window select the Spectral Bands tab.  The default definitions are 
shown below. 

There are two ways to select the type of spectral band. These are: 

• Hot Keys –  To use your PC’s keyboard to make a selection, while the Gauge Window is active 
[has focus] click the applicable numeric key.  For example, clicking on <2> will set the gauges for 
DC Gap Voltage.  Refer to the following table for key associations. 

• Mouse – To make a selection with the mouse open the View pull-down menu, then place the 
mouse cursor over the selection and click on it. 

There is one way to edit the 6 configurable spectral bands; that is from the Setup Configuration window’s 
Spectral Bands tab.  The Setup window is accessed via the Edit pull-down menu. 

 

Hot 
Key 

Spectral Bands 
Use the View Pull-down Menu (or Hot Keys) to 

select the band type. 
Use Edit Menu “Setup” Spectral Bands to edit.  

1 Overall 
2 DC Gap Voltage 
3 1x Amplitude 
4 First Order Phase 

 
These 4 bands have pre-set 
parameters and cannot be 
changed. 

5 2x Amp* 
6 3x Amp* 
7 4x Amp* 
8 5x Amp* 
9 6x Amp* 
0 7x Amp* 

 
These 6 band parameters are 
set in the Setup Configuration 
window under the Spectral 
Bands tab. 

*Default Value 
 

The first four types cannot be modified.  The Overall value is a time domain overall value.  In regard to 
probe values: 

• 

• 

• 

Displacement probe measurements are displayed as peak-to-peak values.

Velocity probe measurements are displayed as zero-to-peak values. 

Accelerometer probe measurements are displayed as zero-to-rms values. 

 

The remaining spectral band types are user defined and can be modified at any time. 

 



Gauge Window – The Lower Panels 
 

 
Gauge Window, Lower Panels 

 

Acquisition Panel 
The Acquisition Panel contains one toggle switch, which determines the ON/OFF status of data acquisition.  
Click this toggle switch to turn data acquisition ON (Up/Green), or OFF (Down/Red). 

Limit Check Panel 
The Limit Check panel contains a toggle switch and an alarm log progress bar.  The Limit Check toggle 
switch determines the ON/OFF status of the Limit Checking feature.  Click this toggle switch to turn limit 
checking ON (Up/Green), or OFF (Down/Red). 

The Alarm Log Progress Bar graphically indicates how full the Alarm File is.   

Double-clicking on the bar, or on its associated text, opens the Alarm Log.  The log can also be accessed 
from the Reports pull-down menu.   The most recent alarm event will appear below the bar. 

Digital I/O (DIO) Panel 
The Digital I/O Panel contains an ON/OFF toggle switch and four push buttons.  The push button icons 
indicate the current status of the digital I/O.  Each time you start  
eZ-TOMAS, the switches will be turned off and appear gray.  The DIO switch must be turned “ON” to 
enable digital I/O functionality.  

If the DIO toggle switch is turned on, Digital I/O relay switches will activate [or deactivate] depending on 
the configuration set in the Digital I/O Configuration window (detailed in chapter 4).  The window is 
accessible via the Edit pull-menu.  

During an acquisition you can manually activate each of the four switches by clicking on the associated 
button. 

Note that in the following figure, the Digital I/O push buttons are, from top down: 
Digital Input, Digital Output [Normally Closed], Digital Output [Normally Opened], and Digital Input.  
These four Digital I/O button icons agree with the setup in the Digital I/O Configuration window as 
indicated in the following figure. 

 
DIO Panel 
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Data Storage Panel 
The Data Storage Panel is easily recognized by its Snapshot [camera] button and the bar for Current Data 
Record / History File Size. 

The bar graphically indicates how full the FIFO file is.  Two numbers, separated by a slash, reside just 
below the progress bar.  In the example this is 500 / 500.   The first number is the current data record 
number; the second is the number of records that can be stored in the FIFO file, also referred to as the 
History File Size.  In this case the data file is full. 

Clicking the <Snap Shot> (camera) button will save “N” seconds of data to the history file; where “N” is 
defined in the Storage Tab [in the Configuration Panel].  The data storage panel includes the Historical Data 
File Date Range.   

Note that you can open the Plot Window from this panel by double-clicking on the capacity bar, the record 
numbers, or the date text. 

 
Data Storage Panel 

FIFO Records Capacity Bar 
 
Number of Records that can be stored 
    (History File Size) 
 
Number of Records currently stored 
 
Data File’s Date/Time Range 

Snapshot 

 
 

Note:  The <Snap Shot> button initiates multiple continuous snapshots for “N” seconds of time data.  The 
time (in seconds) “N” is defined in the Storage Tab of the Setup Configuration Window. 
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Options Panel 
 

The Options Panel provides a means of 
easily displaying the following: 

• peak hold gauge pointers 

• peak values 

• all real time values 
(all gauge values) 

• a list of eZ-TOMAS projects and 
their associated directory 

• a graphic to represent the machine 

 

Display Peak 
Hold Gauge 
Pointers 

Show Peak Hold 
Values 

Reset Peak Hold 
Gauge Values 

Display list of 
TOMAS projects 

 
 

Options Panel 

 

 

 

Display All 
Gauge 
Values 

 

Display 
Machine 
Graphic 
Picture 
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The Options Panel includes a <Reset Peak Hold Gauge Values> button.  Clicking the button momentarily 
resets the peak values.  However, the new peak acquisition values [which exist after the point of reset] will 
immediately apply. 

Clicking the <Display Machine Graphic Picture> button brings up a separate window, which allows you 
to select a jpeg or bitmap image to represent the machine, for example, a picture of an engine or turbine. A 
text field is present, which is convenient for entering a machine identifier, such as a serial number or a 
factory reference label (see figure at right). 

To change the title bar of the machine graphic, pull down the Gauge Window’s” Edit menu, select “Display 
Preferences,” then type the desired entry into the Machine Information panel’s “Name” field. 

In regard to the graphic image, if you right-click in the window, two choices will appear: “Load graphic 
picture” and “Remove Graphic Picture.”  Clicking on the former allow you to browse your PC for the 
appropriate graphic.  Note that this can also be accomplished through the Edit pull-down menu. 

 
   
Machine Graphic Picture
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Network Panel 

 
Network Panel 

The use of this feature requires multiple copies of eZ-TOMAS, one on each networked computer.  Each 
networked computer must have eZ-TOMAS running in order to access the networking functions. 

When networked, a node is set as either a client or a server. A server must be connected to a ZonicBook or 
WaveBook and can be monitored and controlled by a remote client.  A client does not need to have a 
ZonicBook or WaveBook connected, but can still affect the eZ-TOMAS settings on the server.   

The Network Panel lists all nodes (computers) networked with this machine.  An S indicates that a 
computer is acting as a Server; C indicates it is a Client to the Server; F or a blank space indicates that a 
computer is free, i.e, neither a server nor a client. 

To add new nodes, use the Configure Network Nodes window, accessible by selecting Network... under 
the Edit menu. 

To the right of the list of network nodes, the current status of the network connection is displayed. The 
status messages apply only to the current network connection between a client and a server. There are four 
status messages that can be displayed:  

When not connected, the message “Listening to Network...” appears.  • 

• 

• 

• 

While scanning for a ZonicBook or WaveBook, the message “Connecting to <computer 
name> on port <number>...” appears. Port numbers will be searched until a ZonicBook or 
WaveBook is detected. 

If acting as a client that is connected to a server, the message will read “Received”, followed 
by a series of code letters. Below this, the current time will be displayed.  

If acting as a server, and a client has connected, the message “Network Xfer. Delay: <number 
of seconds>” will appear, followed by a series of code letters.  

 

Once a network connection is established, a connection icon (two computers connected by an arrow) and a 
disconnect button (a large “X”) will be displayed below the status message. The name of the computer 
connected to will also appear below the two buttons. 

To connect to a network node, find the computer name you wish to connect to in the network node list, 
and left-click on it. eZ-TOMAS will establish the client/server relationship. 

To disconnect to a network node, click on the disconnect button, which appears at the bottom of the 
network status window. 
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Monitoring a Machine 2 
 
 
Creating a Project …… 2-1 
Configuring the Project …… 2-2 
Starting an Acquisition …… 2-4 
Viewing Spectral Bands …… 2-4 
Plotting Data …… 2-4 

Multiple Plots …… 2-4 
“Real Time” Plot Controls …… 2-5 
“History Data” Plot Controls …… 2-6 

Viewing Reports …… 2-7 
 

Creating a Project 
An eZ-TOMAS Project is a collection of data files, typically associated with a monitored machine.  The 
data files include configuration and measured data.  When eZ-TOMAS runs it attempts to open the last eZ-
TOMAS Project accessed. 

If you are monitoring a machine for the first time, you should create a new eZ-TOMAS Project to store the 
machine’s configuration and vibration data.  If you have already created an eZ-TOMAS Project for the 
machine, use the File Open menu to pick up where you left off.  

The vibration data files have a FIFO design.  When you turn on the acquisition switch, data will be 
appended to the data files. 

 

 
 
 

If you have multiple hardware modules, and change the number of Input Channels, 
you need to use the File Initialize Project to create a new Tomas Project. 
 

 

Each eZ-TOMAS Project contains eZ-TOMAS configuration and data files.  You should logically equate 
an eZ-TOMAS Project with a specific machine.  This is accomplished as follows: 

1. On the File pull-down menu, select New Project.  This opens the Save As window. 

Save As Window, Being Used to Create a New File 

2. Select [or create] a Windows folder for the eZ-TOMAS Project.   

3. Enter the desired filename for this project. 

4. Click the <Save> button to create the new project. 
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Configuring the Project 
A default configuration is automatically loaded when you open an eZ-TOMAS file.  However, you may 
want to make some changes to the configuration.  To make changes: 

1. From the eZ-TOMAS Main Window, open the Edit pull-down menu. 

2. In the Edit menu select Setup.  The Setup Configuration window will appear. 

 

Reference Note: 
The four tabs of the Setup Configuration window are labeled: Acquisition, Input Channels, 
Spectral Bands, and Storage.  They are discussed briefly in this section and in detail at the 
beginning of Chapter 4, Edit Menu. 

3. Make sure that the Hardware panel reflects the correct device, i.e., ZonicBook or WaveBook.  

 
Setup Configuration Window, Acquisition Tab 
The selected hardware is an 8 channel ZonicBook. 

 
 

 
 
 

Clicking the <Cancel> button will undo all the changes you’ve made since you 
opened the Setup Configuration Window. 
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Setup Configuration Window, Acquisition Tab 

The selected hardware is a WaveBook/516 and a WBK18 module. 

 

4. Make the desired changes for each of the tabs and then click the <Save> button.  

You can start monitoring immediately. 

 

Acquisition Tab – From the Acquisition tab you can set up parameters that include, but are not limited 
to:  Block Size, Analysis Frequency, Low Cutoff Frequency, FFT Window, and Number of Averages. 

Input Channels Tab – From the Input Channels Tab you can change channel parameters.  This 
includes, but is not limited to assigning channel types, customizing channel names, setting the instrument 
range per channel, and assigning units. 

Spectral Bands Tab - From the Spectral Bands Tab you can modify bands 5 through 10 according to 
your application.  Note that the first four Bands [Overall, DC Gap V, 1x Amplitude, and 1x Phase] are 
predefined. 

Storage Tab - From the Storage Tab you can specify how you want trigger data storage.  If any one 
event is triggered, data from all channels is stored.  Data storage events are triggered when a change occurs 
in the monitored machine’s condition.  The basic idea is to activate storage based on Time Change and/or 
Speed Change and/or Amplitude Change. 

 

Refer to chapter 4 for more information regarding the Setup Configuration tabs. 
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Starting an Acquisition 
After you configure your eZ-TOMAS Project, click the <Acquisition> Toggle Switch to 
place it in the upright position.  This starts the data acquisition.  The switch is located in the 
in the lower left corner of the eZ-TOMAS gauge window. 

When acquisition is active, real time overall values are displayed in the instrument gauges.  
 The toggle switch is green while data acquisition is active.  

To stop data acquisition, click the switch toggling it down (red). 

Viewing Spectral Bands 
The Main Window’s gauges can be used to display different spectral bands.  On the View menu select the 
band of interest, e.g., Overall, DC Gap V, 1xAmplitude, 1xPhase, or one of the user-defined bands. 

 

 
Spectral Bands, 1xAmplitude is Selected 

Plotting Data 
Click on “Plots” in the main window’s menu bar.  The Data Display window will open.  Note that you can 
double-click on a gauge to plot data for that specific gauge. 

Multiple Plots  
1. On the File pull-down menu of the Plots window, select Open Plot Window. 

This opens a second display window. 

2. On the Window pull-down menu of the Plots window, select either Tile Vertically or  
Tile Horizontally. 
 
All display windows will be shown simultaneously. 

3. Select the Channel(s) and Display type for each window. 
 

2-4 897096 eZ-TOMAS, Monitoring a Project 



 
Time Display and Spectrum Display Plots Tiled Horizontally 

Each plot is longer in the horizontal direction. 

 
A cursor is provided with each display. To move the cursor, place your mouse icon over the cursor and 
drag it to the desired location on the trace or use the East / West Arrows. 

 

“Real Time” Plot Controls 
“Real Time” is the default data source.  For Real Time displays you can Halt and Resume the display of 
data by using the <Pause/Continue> toggle button (see following figure).  As an option to the 
<Pause/Continue> button you can use the “P” key on the PC’s keyboard.   
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Selects “Real Time” Mode             Pause/Continue 

 

 

Real Time Mode is Selected 

 

 

 

Reference Note: 
Refer to chapter 6 for more detailed information regarding Plots and the associated toolbar 
buttons and other controls. 

 

 



“History Data” Plot Controls 
When viewing History Data (pre-recorded data files), you can use the set of playback buttons or the slider 
bar to navigate through the data.  A table, which identifies all control buttons, is included in chapter 6.  
Note that the playback buttons and slider remain hidden in the GUI when eZ-TOMAS is in the Real Time 
mode. 

History Data is accumulated according to the parameters setup in the Setup Configuration window’s 
Storage Tab, which is accessed via the Gauge Panel window’s Edit Menu. 

 

 

 

 

 

Selects “History Data” Mode          Playback Buttons           Slider 

 

 

 
History Data (Playback) Mode is Selected 

Data Source- 
History File 
 
 
 
 
 
 
 
Use sliders 
to set the 
start and 
stop times 
for the 
desired 
playback. 

2-6 
 

 

Show 
Alarm Log 
 
 
 
Show 
Snapshot Log 
 

 

 

Reference Note: 
Refer to chapter 6 for more detailed information regarding Plot displays, associated toolbar 
buttons, and other controls. 
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Viewing Reports 
 

eZ-TOMAS can generate the following types of reports, which are accessible from the Reports pull-down 
menu.  

• Statistical Report 

• Alarm Log 

• Snapshot Log 

• Configuration Setup text file (.txt) 

 

The Statistical Report lists the historical spectral band data.  It includes the instrument, the engineering 
units, the minimum value, the mean average value, the maximum value, and the standard deviation by 
channel.   Statistical reports can be used to automatically generate limit values based on historical data. 

The Alarm Log contains the last “N” number of alarms.  The number of alarms was specified in the Setup 
Configuration window under the Storage Tab.  The Alarm Log (following figure) includes the date and 
time, the channel number, reference tachometer, instrument name, spectral band type, alarm type, and value 
of the alarm signal.  

The Snapshot Log can be accessed from the Reports pull-down menu, or from the History Data Window.  
The Snapshot Log file contains entries which were created whenever the user clicked the <Snapshot> 
button, which is located in the Gauge Window’s Data Storage panel. 

Selecting Configuration Setup from the Reports pull-down menu creates a text file that contains 
configuration details of the current project. 

 

 

 

Reference Note: 
Refer to Chapter 7, Reports, for detailed information regarding each report type and for 
instructions pertaining to generating limits. 
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File Menu   [In Gauge Window] 3 
 

New Project ...... 3-1 Note:  The File Menu discussed in this chapter is located 
in the Gauge Window’s menu bar.  It is not to be 
confused with the Plot Window’s File Menu. 

Initialize Project ...... 3-1 
Open Project …… 3-2
Save As ...... 3-2 
Erase History File …... 3-3 
Print …… 3-4 
Exit …… 3-4  

 

 

New Project 
The New Project option opens the Save As window.  The first step 
in creating a new project is to select or create a Folder where the 
new project’s files should be saved.  Enter a filename for the 
project, then click the <Save> button.  

Note that the Save As window that is accessed via the New Project 
selection is not the same as Window that results from clicking the 
“Save As” option in the Gauge Window’s File pull-down menu.   
The later is for saving one of three backup formats.  These are: 
Entire Project, Partial Project, and Gauge Data (ASCII).  After 
selecting one of the three formats and clicking the <Save> button, 
the Save As window will appear.  

 

 

Initialize Project 
To inform eZ-TOMAS as to what type of hardware will be used, 
used, select “Initialize Project” from the Gauge Window’s File pull-
down menu.  The resulting window allows you to select a Hardware 
Device [WaveBook or ZonicBook] and the applicable number of 
input channels. 
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Using the Save As Window to
 Create a New Project 
Initialize Project 
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Open Project 
The Open Project option provides a means of locating and opening an existing eZ-TOMAS project.  

Note: When eZ-TOMAS is started, it opens the last active project. 
 
 

Save As 
The Save As option allows you to backup history files in a binary file format, or export files in an ASCII 
file format.  This command opens the Backup/Save eZ-TOMAS Project window. The options in this 
window change as you make selections. You can backup and export full or partial files.  

Note: The disk space required to backup the selected records is displayed on the left panel. 
 

Entire Project 
The Entire Project option is only available when data 
acquisition is turned off.  Entire Project performs a file copy 
operation to the specified Windows Directory.  This backup 
method is the fastest.  

 

 

 

Save As… Entire Project 

 

Partial Project 
The Partial Project option can be used when data acquisition is 
active.  This option copies data and the configuration setup to the 
designated folder for the date and time range specified in the panel 
on the right.  

To make a partial backup: 

1. Use the sliders in the Partial Project Backup panel (see figure 
at right) to select the start and stop times of the range that you 
want included in the backup. 

2. Click the <Save> button.  The Save As window will open. 

3. Select the folder where the file is to be saved. 

4. Enter a filename. 

5. Click the <Save> button. 

 

 

Save As… Partial Project 
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Backup Format - ASCII 
This option creates an exportable ASCII file for the gauge data.  

    

Save As… ASCII File 

 

Erase History File 

Erase History Warning 

 

Use the Erase History File option with caution.  This menu item will erase the History File 
for the project. All data for the active project will be permanently removed.  It is not 
recoverable. 

The configuration information will not be erased. 
.  
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Print 
Brings up the Print Window for printing the current screen. 

 

Exit 
Closes the eZ-TOMAS application. 
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 Setup…… 4-1 
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Spectral Bands Tab …… 4-6 

Tach Reference …… 4-5 
Spectral Bands …… 4-5 

Storage Tab …… 4-7 
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Network …… 4-13 
Display Preferences …… 4-14 
Copy Window …… 4-14
Load [or Remove] Graphic Picture … 4-
Reset Peak Hold Values …… 4-14 
 

Setup…… 
The Setup Configuration Window has individu
appropriate tab at the top of the window to con
necessary changes in each panel. Click the <O

 

 
 
 

Clicking the <Cancel> button 
opened the Setup Configuratio

 

Setup Configuration
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Note:  The Edit Menu discussed in this chapter is located
in the Gauge Window’s menu bar.  It is not to be 
confused with the Plot Window’s Edit Menu. 
The Gauge Window’s Edit pull-down menu is 
significant in that it is used to modify project 
configuration files.  After selecting Edit on the 
Main Window’s menu bar you can: 

• 

• 

Select Setup to configure your acquisition 
device for data acquisition. 

Select Limits to set values for the lower and 
upper Alert and Alarm limits. 14 

al panels for configuring the acquisition device. Click the 
figure the ZonicBook or WaveBook system.  Make the 
K> button to save all your changes and close the window. 

will undo all the changes you’ve made since you 
n Window. 

 
 Window, Acquisition Tab Selected 
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Acquisition Tab 

 Acquisition Tab 

 

The Acquisition tab is used to configure how the data will be acquired and processed. 

Block Size:  is the number  samples per block of vibration data.  For example, a 2048 
Block size contains 2048 data samples and will produce an 800 line spectrum.  
A larger Block size provides greater data resolution.  However, it takes longer 
to collect the data and more disk space to store it. 

Analysis Frequency:  is the maximum frequency of interest.  The sampling rate will be 2.56 times 
the analysis frequency.  Verify the maximum frequency response of your 
probes.  For a Tach signal, your Analysis Frequency should be a higher 
multiple of the maximum rotating speed.  Typically, this multiple is at least 
10 times the rotating frequency. 

Low Frequency Cutoff:  Allows you to eliminate the lower frequencies from the full frequency range. 
Number of Averages:   The number of data blocks averaged before a block of data is accepted and 

displayed.  Typically, the value is “1” indicating no averaging. 
FFT Window  
(Weighting window):  

is typically either Hanning or Flat Top. Hanning provides better frequency 
resolution. Flat Top provides better amplitude resolution. 

RT Display Buffer:  This option is primarily for Strip Chart Displays.  It controls the amount of 
time that is displayed across the x-axis.  Your choices are up to 480 minutes.  
The longer times are especially useful when you are trying to see trending for 
a slow process. 

 

 

You must turn acquisition on and then off again for Acquisition Configuration changes 
to take effect. 

 

  

4-2 897096 eZ-TOMAS, Edit Menu  



Input Channels Tab 
This tab is used to configure each channel for your project.  The available setup options in this window are 
dependent on the instrument type selected.   

 

Input Channels Tab, Showing the Leftmost Columns 
 

To configure a channel: 

1. Select the channel to be configured. 
2. Set the instrument type. 
3. Set the value for each attribute of the channel. 

Repeat this process for each channel.  

 
The parameters of one channel can be copied to another channel by using 
options on the Edit menu. 

 

 
ZonicBook Users Only:  Configure the Dip Switches for each probe, according to probe 
type.   Refer to the ZonicBook Getting Started Manual (p/n 1086-0901) for details. 

 

No.:  is the channel number.  Selecting the channel number highlights all attributes for 
that channel. 

Type:  is the type of instrument attached to the channel. Options are Accelerometer, 
Velocity, Displacement, Static and Tach.  If the channel does not have an 
instrument attached, select Unused. 

Name:  is a Label you will use to identify the channel. 

Min, and Max:  represent the instrument range. 

Units:  is the Engineering Units you want to use.  Options depend on the instrument 
type. 

FSV  
(Full Scale Voltage): 

is the maximum input voltage for the instrument.  If you are unsure of the 
instrument’s maximum voltage value, select a high voltage value. 

mVolt / EU: is the instrument sensitivity.  (Typical displacement probes: 200 milli-Volts per 
mil.  Typical accelerometer probes: 100 milliVolts per G.  For Tach probes  
enter 1000.) For static channels, this property represents the slope variable (m) of 
the linear equation y = mx + b. 
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Integration:  Accelerometer and Velocity signals can be integrated.  Select the desired 
integration value.  If the signal is acceleration, then single integration results in 
velocity, and double integration results in displacement. If the signal is 
velocity, then single integration results in displacement. 

Integration Units:  are g’s/ips/mils, g’s/ips/mils, g’s/ips/in, and g’s/mmps/mm. 

Angle:  is the physical angular location of a probe.  Zero degrees is defined to be the 
top dead center.  The angle value is measured in the counterclockwise (CCW) 
direction as viewed from the driver end.  Orbit and Polar displays utilize 
Instrument Angle for data correction. 

Gap Volt:  is the DC voltage value when the shaft is at rest.  This value is used for Shaft 
Center Line displays. 

1xAmpRef and 
1xPhsRef:  

are the slow roll values used for Runout Compensation on Bode or Polar 
displays. 

XY Pair:  associates 2 probes on a bearing.  Typically, probe pairs are located 90 degrees 
apart.  Orbit displays require a Channel Pair. 

 
 

 
Input Channels Tab, Scrolled to Show the Rightmost Columns 

 
 

Bearing Clearance:  is measured in the instrument’s engineering units.  You can optionally overlay 
the bearing clearance circle onto an orbit display or shaft centerline. 

Bearing Start: Bearing start is the location of the shaft relative to the bearing when the 
machine is at mechanical rest.  Three possible locations are taken into 
consideration: Bottom, Center, and Top.  For horizontal shafts, a bearing start 
of bottom is typical, due to gravity; However, in some situations mechanical 
linkage can result in a bearing start with the shaft at the top.  For shafts that are 
oriented vertically, a bearing start of center is likely. 

Tach Reference: A right-click in the Tach Reference column brings up a pull-down list, which 
indicates the tachometer channels that are available to be used as a reference 
for the currently displayed data. 
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Tach Section of the Input Channels Tab 

Rotation:  is the shaft’s rotation direction, either clockwise (CW) or counter-clockwise 
(CCW), as viewed from the driver end of the machine train. 

Trig/Rev:  is the number of pulses per 360 degree revolution. (Default: 1) 

Trig Dir:  is the “negative’ or “positive” direction of the moving shaft. 

Trig Volt: defines the Tach pulse for tach signals.  A keyway will generate a Negative 
Tach pulse.  Typical Tach signals will generate at least a 1 V pulse.  You can 
check the voltage value using a Time display. 

 
 

Tachometer Notes 

To Assign a 
Tachometer to a 
Channel 

1. Navigate in eZ-TOMAS as follows:  Edit [pull-down men] \ Setup 
Configuration \ Input Channels Tab \ Tach Ref column. 

2. Left-click in the Tach Ref column and select the desired tachometer from the 
pull-down list. 

To Assign 
Tachometers to 
the Gauge 
Window View 

1. Select “View” from the gage window’s tool bar. 

2. From the resulting list, select the desired Tach, or select Tach Reference.  
Note that a Tach selection option will only be available if there are two or 
more tachometers to choose from. 

If you select a Tach, for example, Tach 1 – that Tachometer will apply to all 
applicable gauges, regardless of what tachometer is assigned to the channel 
in Setup Configuration. 

If you select “Tach Reference,” Tachometers will apply to the gauges in 
accordance with the Setup Configuration assignments, as described in row 1 
of this table, which describes how to assign a tachometer to a channel. 

To Edit a 
Tachometer 
Channel's 
Parameters 

1. Navigate in eZ-TOMAS as follows:  Edit [pull-down menu] \ Setup 
Configuration \ Input Channels tab. 

2. Edit the parameters on a column by column basis, as desired.  Note that there 
are two places from which you can edit tachometer parameters: 
(a) The main area of the Input Channels tab.  This is where you can edit the 
tachometer channel’s name, minimum and maximum gauge values, units, 
etc. 
(b) The lower panel of the Input Channels tab.  From here you can configure 
the tachometer channel’s rotation (CW or CCW), trigger/revolution, trigger 
direction (POS or NEG), and trigger voltage. 

For applicable illustrations of the channel configuration areas, refer to the 
preceding two figures. 
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Spectral Bands Tab 
Up to 10 Spectral Bands can be defined for each dynamic channel.  The first four Bands are predefined as 
Overall, DC Gap V, 1x Amplitude, and 1x Phase.  You can modify Bands 5 through 10 for your specific 
application.  Spectral Band values are displayed on the dynamic instrument gauges, on the eZ-TOMAS 
main window.   

 
Spectral Bands Tab 

Tach Reference:  Refers to the tach channels being used in the project.  You must select the 
tach of interest. 

Channel Name:  is the name you assigned to the input channel in the Channels Panel. 

Band:  is the Spectral Band Number of interest.  Bands 1 through 4 cannot be 
edited. 

Spectral Band Name:  is the name you assign to a spectral band.  It is displayed on the dynamic 
instrument gauge in the main window. 

Range Low and Range High:  is the frequency or order range.  It is a good practice to set the range 2 to 
4 spectral lines wider than the frequency of interest.  This is due to the 
FFT window.  For example, if your frequency of interest is the 3rd order.  
You should specify a range of 2.9 to 3.1 orders 

Units:  can be either Frequency or Orders.  If you do not have a tach defined, the 
Orders option will not be available. 

Find:  specifies Peak, Overall, or Phase.  
Peak is the highest spectral amplitude within the specified range.  
Overall is the sum of vibrations of each spectral amplitude within the 
specified range. 
Phase is the time relationship between the vibration probe and tach 
signal. 
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 Storage Tab 

 
Storage Tab 

Basic Description 
Data storage is activated by trigger events.  If any one event is triggered, data from all channels is stored.  
Data storage events are triggered when a change occurs within the range of your defined parameters.  An 
example follows the parameter definitions. 

Time Change:  is a time-based storage trigger.  Enter the number of seconds, minutes, hours, or days 
between desired storage events. 

Speed Change:  is an RPM based storage trigger.  Data will be stored when the machine speed 
changes by the defined value in rpm, Kcpm, or Hz. 

Overall Change:  is an amplitude-based storage trigger that can be defined for each channel.  Data is 
stored when the overall amplitude changes by the specified value.  This can be 
controlled on a channel-by-channel bases by selecting “True” or “False” in the 
Enabled column. 

RPM Range:   is the range in which a one of the above changes must occur to trigger data storage.    
When Not Enabled is selected, any of the above changes can cause data to be stored 
regardless of the machine’s operating speed. 

History FIFO 
No. of Records:  

is the number of storage records in the History FIFO (First-In-First-Out)  file.  Based 
on the configuration, values for both the required and the available disk space are 
shown to the right of the “No. of Records” field. 

 

The history file is a FIFO file.  You can define the depth of the history file; however, the amount of time 
needed to fill the file depends on the trigger event values.  The smaller the trigger values, the faster the 
history file fills.  The current data storage status is shown in the Main Window. 
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Example 
Assume that a motor typically runs at 3600 RPM and we would like to store data when the motor is running 
above 200 RPM and below 5000 RPM.  

1. Open the Edit menu. 

2. Select “Setup.”  The Setup Configuration window will open. 

3. Select “Storage Tab.” 

4. For RPM Range enter a value of 5000 for the maximum and 200 for the minimum. 

 
5. Set one or more of the following to trigger data storage: 

a) Time Change 
b) Speed Change 
c) Overall Change (the overall change in engineering units) 
 
For this example assume that  Time Change and Speed Change were both set to “None” and 
the Overall Change trigger for a channel was set to set to 0.25 mils.  
 

6. Click <OK>. 

With this configuration, data will be stored if . . .  the motor’s speed is greater than 200 RPM and less 
than 5000 RPM and the overall value changes by 0.25 mils [since the last trigger event].   In this case  
eZ-TOMAS will store time and spectral data for all channels.  All event triggers are reset whenever any 
event trigger occurs. 

In other words: 

IF  minRPM < Motor Speed < maxRPM 

AND IF {delta Time, OR delta Speed, OR delta EU= specified setting} 

THEN data is stored. 
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Limits  
There are two ways to generate and modify limits. The global way is to use the statistical report.  Statistical 
reports can be used to automatically generate limit values based on historical data. 

The Limits window is used when you want to manually modify or enter specific limits.  

 

 

 
For more details on setting limits refer to the section entitled Statistical Report. 

 

Limit Configuration 

 
Up to two High and two Low limits can be defined for each channel’s operating condition.  When the 
instrument status changes (Alert or Danger), a single system beep is issued.   

Limit colors can be specified in the Display Preferences Window, which is accessed via the Edit pull-down 
menu. 

 

 

Limit values are not used if: 
(a)  the ‘HiHi limit value’ minus the ‘LoLo limit value’ is less than 5% of the 

instrument scale, or 
(b)  the limit value is outside of the instrument range. 

 

 

Limits from one channel can be copied to another from the Limit Configuration 
Window’s Edit pull-down menu, using the “Copy Channel” option, or by selecting 
multiple channels. 
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Tach  you may have up to three tachs per project.  Select the tach reference for the 
limits. 

Channel  Number of interest.  Select the channel(s) of interest. 

Spectral Band  to which the limits should be applied. ( i.e. Overall, DC Gap, 1xAmplitude, 
1xPhase) 

HIHI, HI, LO, LOLO  are Limits.  Up to two High and two Low limits can be defined for each 
channel’s operating condition.   Limit values are typed (entered) into the 
applicable rows and columns.  See previous figure. 

  

 

You can modify limits on the graphical gauge display in the main window by dragging 
the limit arrows and then opening this window to save your changes. 

  
FIFO Records  is the number of Alarm events logged.  When an alarm occurs, eZ-TOMAS 

automatically saves the data to the History FIFO file. 

RPM Range the RPM range as defined by the minimum and maximum RPM values of the 
limit check.  This RPM Range is the limit check range. 
 

 

Assume that a motor typically runs at 3600 RPM and that we want to run a limit check on vibration when 
the motor’s speed is in the range of 3500 RPM and 3700 RPM.    

1. Open the Edit menu. 

2. Select “Limits.”  The Limit Configuration window will open. 

3. In the Limit Configuration window enter an “RPM Range for Limit Check” value of 3500 in the 
first field and 3700 in the second.  These are the minimum and maximum RPM values of our limit 
check range. 
 

 
4. Check “Enabled” under the text, “RPM Range.” 

5. Click <OK>.   
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Digital I/O Configuration 

Hardware Panel 
The top panel of the Digital I/O Configuration Window is the Hardware panel (see following figure).   

To ensure proper output: (1) an NDTRelay must be connected as indicated in separate NDTRelay 
documentation,  (2) the relay’s model number must be indicated in eZ-TOMAS’s Digital I/O 
Configuration window and (3) the applicable COM Port must be identified. 

 Model Number:  Select the applicable output relay module:  NDTRelay1 or NDTRelay2. 

 RS 232 COM Port:  Select the COM (serial) Port to which the output Relay module is connected. 

 Sets the Digital 
Output’s Normal 
State to “Opened” 
or “Closed” 

Time (seconds) 
that the Digital 
Output is to be 
Active 
 
 
Action Selected 
(from pull-down 
list) for Digital 
Input 
  
Digital Input 
is Selected 
 
 
Digital Output 
is Selected 
 
 
Enable/Disable 
Digital I/O 
 
Alarm Event for
Digital Output 
 

 
Digital I/O Configuration, Accessible from the Edit Pull-Down Menu (2 views) 
The panel below the Digital I/O Panel will be an Alarm Event panel for Digital Output channels, as indicated in the 
left-hand image; and will be an Action Performed panel for Digital Input channels, as indicated in the right-hand 
image. 
 

Digital I/O Channels Panel 
The second panel of the Digital I/O Configuration window is the Digital I/O Channels panel.  There are 
four Digital I/O channels, each of which can be configured for digital input or digital output.  As seen in the 
above figure [which shows a Digital Output example on the left and a Digital Input example on the right]. 

Each of the 4 channels has a Checkbox that is used to enable or disable the digital I/O function of the 
channel.  A checkmark in the box indicates that the channel is active. 

• 

• 

• 

• 

The “DI / DO” column is used to select Digital Input or Digital Output.  Clicking on the small 
schematic icon (in the column) toggles between the two options, i.e., Input and Output and displays an 
associated image.  The arrow going into a connector represents Digital Input, the arrow leaving the 
connector represents Digital Output. 

The “NO / NC” column refers to the normal state of the Digital Output. The normal state can be set to 
be Normally Opened or Normally Closed on limit/alarm status.  You can use up to four relays.  A blue 
line, showing an open between two points is used for Normally Open.  A red line, connecting two 
points, is used for Normally Closed. 
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The DO Timer column refers to the time [in seconds] that the Digital Output is to be active.  The DO 
Timer box will display “n/a” when Digital I/O is selected. 

 



 

Alarm Events Panel (Digital Output Only)  
The color of the response channel in the “Alarm Events” panel indicates the limit/alarm status that will 
cause the switch to change status, i.e., from Opened to Closed, or visa versa.  Click on a channel number 
until the desired limit color is displayed.  If the relay is normally Opened when monitored data causes the 
specified limit/alarm, the relay will change to Closed for the duration specified by the timer; then it will 
return to the normally Opened status. 

Note that you can have the system count the number of consecutive alarms and change the relay status 
when that number of alarms is reached. 

 

Action Performed Panel (Digital Input Only) 
This panel consists of a pull-down list that allows you to select one of several “actions” for Digital Input 
applications. 

Possible actions are: 

• Store Snapshot 
• Change Acquisition State 
• Change Limit Check State 
• Increment Serial Number 
• Increment Serial Number and Reset Peak Hold 

 

 

When you click the Save button, any of the unchecked check boxes for relay channels 
will close and stay closed until the condition is met for that relay channel.  If you have 
something that will actuate when the channel closes, it will do so as soon as you click the 
Save button. 
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Network 
This feature requires multiple copies of eZ-TOMAS, one on 
each networked computer.  Each networked computer must have  
eZ-TOMAS running in order to access the networking functions. 

When networked, a node is set as either a client or a server. A server 
must be connected to a ZonicBook, and can be monitored and 
controlled by a remote client; a client does not need to have a 
ZonicBook connected, but can effect the eZ-TOMAS settings on the 
server.   

The Network Panel lists all nodes (computers) networked with this 
machine.  An S indicates that a computer is acting as a Server; C indicates it is a Client to the Server; F or a 
blank space indicates that a computer is free, i.e, neither a server nor a client. 

To add new nodes, use the Configure Network Nodes window, accessible by selecting Network... under 
the Edit menu. 

To the right of the list of network nodes, the current status of the network connection is displayed. The 
status messages apply only to the current network connection between a client and a server. There are four 
status messages that can be displayed:  

When not connected, the message: 
 “Listening to Network...” appears.  

• 

• 

• 

• 

While scanning for a device, the message: 
 “Connecting to <computer name> on port <number>...” appears.  
Port numbers will be searched until a ZonicBook or WaveBook is detected. 

If acting as a client that is connected to a server, the message will read: 
 “Received”, followed by a series of code letters. Below this, the current time will be displayed.  

If acting as a server, and a client has connected, the message: 
“Network Xfer. Delay: <number of seconds>” will appear.   
This will be followed by a series of code letters.  

 

Once a network connection is established, a connection icon (two computers connected by an arrow) and a 
disconnect button (a large “X”)  will be displayed below the status message. The name of the computer 
connected to will also appear below the two buttons. 

To connect to a network node: 
Find the computer name you wish to connect to in the network node list, and left-click on it.  
eZ-TOMAS will establish the client/server relationship. 

To disconnect to a network node: 
Click on the disconnect button, which appears at the bottom of the network status window. 
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Display Preferences Window 

 
Display Preferences Window 

The Display Preferences Window provides a means of changing various display colors and other 
parameters, including, but not limited to, Waterfall latitude and longitude angles, and units for the 
frequency axis.  If a machine name is entered (upper-right text field), it will appear on the eZ-TOMAS 
main window, in the Machine Description region.  See the following figure for location.  

Copy Window 
“Copy Window” is not a window, but a command to copy the currently selected window to the clipboard.  
After using this command you can paste the copied window into another application, such as Microsoft 
Word or Excel.   The feature is useful for creating reports, or sending screen images to others via e-mail. 

Load [or Remove] Graphic Picture 
The Load command places a selected graphic ( .bmp or .jpg format) into the 
Machine Description Window.  The Remove command removes it. 

An alternative to using the command is to right-click in the graphic region.  
You can then load the desired graphic file.  Right-clicking in this region also 
provides you with the option of removing an existing graphic.  

The title bar text is entered in the Display Preferences Window (accessed via 
the Edit pull-down menu.  The lower text field information is entered directly 
into the field. 

 

Reset Peak Hold Values 

Momentarily resets the peak values.  However, the new peak acquisition values [which exist from the point of 
reset] will immediately apply. 
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View Menu   [In Gauge Window] 5 
The gauges in the Main Window display the real time data for the selected spectral band.  The View pull-
down menu provides a means of selecting the type of spectral band to be viewed.  In the following figure 
“1xPhase” is selected.   

Text, which indicates the spectral band type, is displayed at the bottom of each gage. 

 

 
Using the View Pull-Down Menu to Select 

the Spectral Band Type and the Tachometer to be Referenced 

 
Instead of using the View menu, you can use the designated hotkeys to change the spectral band type. 
The hot keys are indicated in the following table. 
 

Hot 
Key 

Spectral Bands 
Use the View Pull-down Menu (or Hot Keys) to 

select the band type. 
Use Edit Menu “Setup” Spectral Bands to edit.  

1 Overall 
2 DC Gap Voltage 
3 1x Amplitude 
4 First Order Phase 

 
These 4 bands have pre-set 
parameters and cannot be 
changed. 

5 2x Amp* 
6 3x Amp* 
7 4x Amp* 
8 5x Amp* 
9 6x Amp* 
0 7x Amp* 

 
These 6 band parameters are 
set in the Setup 
Configuration window under 
the Spectral Bands tab. 

*Default Value 
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The list of Spectral Band types is followed by available Tach Channels.  However, if there is only one  
Tach Ch that could be referenced it will not show on the list since no selection is possible.  The Tach Ch 
selection is followed by another option labeled “Tach Reference.” 

If you select a tachometer, for example Tach Ch  4 – then that tachometer will apply to all gauges, 
regardless of what tachometer is assigned to the channel in Setup Configuration.   

If you select “Tach Reference” Tachometers will apply to the gauges in accordance with the Setup 
Configuration assignments, which is accomplished in two steps: 

(1) navigate in eZ-TOMAS as follows:  Edit [pull-down men] \ Setup Configuration  
\ Input Channels Tab \ Tach Ref column.   

(2)  Left-click in the Tach Ref column and select the desired tachometer from the pull-down list. 
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Introduction 
Although located in the menu bar of eZ-TOMAS’s main window, “Plots” functions as a button, not as 
a pull-down menu.  When you click on Plots, a Data Display window opens.  Note that you can double-
click on a gauge to open a Data Display window for plotting that gauge’s data. 

For real-time displays, you can halt and resume the display of data by using the Pause/Continue toggle 
button, or use the “P” key on the keyboard. When viewing historical data, you can use the five playback 
buttons and the slider to navigate through the data (see the following figure). 

You can view either real-time data or historical data.  In the examples that follow we are view historical 
data, thus the History button has been clicked, and appears “active” [green] on our screen. 

Prior to viewing a plot you need to: 

select the channels to be displayed • 
• 
• 
• 

select the desired data display format, e.g., Time Display, Spectrum, or Waterfall 
select the data source, i.e., a “Real Time” source, or a history data file.   
change the scale, if desired 
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In the following Plot Display we (a) selected channel 1, (b) have selected a format of Time Display,  
(c) are using historical data, thus the History button is active, and (d) have chosen the Instrument Scale 
over the other two options (Auto Scale and  User Scale).  The three scales are discussed on page 6-7.   

 
History Data – Time Waveform 

 
Plot controls can be data that is in “Real Time” or pre-recorded, i.e., “History Data.”  A different set of control 
buttons will be present depending on which mode you are using.  In addition, Time Display and Spectrum 
Display formats differ in regard to certain control options.   
 
 

Changing Display Ranges and Scales 

 

Changing the Display Range 
To change the maximum or minimum range value:  Left-click on upper or lower scale value that is to be changed, then 
enter the new value.  An example follows.  This technique works for both X and Y axis. 

 

 

In this example, the cursor and PC 
keyboard were used to change the 
maximum scale value from 3.000 volts 
to 3.800 volts.  
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To change the X-Axis:  Hold down the <Ctrl> key, at the same time, left-click and drag the mouse cursor horizontally on 
the plot.  Two vertical cursor lines will define the new x-axis end points. 

 

To change the Y-Axis:  Hold down the <Alt> key, at the same time, left-click and drag the mouse cursor vertically on the 
plot. Two horizontal cursor lines will define the new Y-axis end-points.  

 

To simultaneously change the X & Y Axes:  Hold down the <Ctrl> and <Alt> keys, at the same time, left-click and drag 
the mouse cursor diagonally on the plot.  A rectangle will define the new area of the plot. 
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“Real Time” Plot Controls 
“Real Time” is the default data source.  For Real Time displays you can Halt and Resume the display of 
data by using the <Pause/Continue> toggle button (see following figure).  As an option to the 
<Pause/Continue> button you can use the “P” key on the PC’s keyboard.  A table, which identifies all 
control buttons follows shortly. 

 

6-4 

 

 

 

Selects “Real Time” Mode             Pause/Continue 

 

 

Real Time Mode is Selected 

 

“History Data” Plot Controls 
When viewing History Data (pre-recorded data files), you can use the set of playback buttons or the slider 
bar to navigate through the data.  A table, which identifies all control buttons, is included on the following 
page.  Note that the playback buttons and slider remain hidden in the GUI when eZ-TOMAS is in the Real 
Time mode. 

History Data is accumulated according to the parameters setup in the Setup Configuration window’s 
Storage Tab, which is accessed via the Gauge Panel window’s Edit Menu. 

 

 

 

 

 

Selects “History Data” Mode          Playback Buttons           Slider 

 

 

 
History Data (Playback) Mode is Selected 

Data Source- 
History File 
 
 
 
 
 
 
 
Use sliders 
to set the 
start and 
stop times 
for the 
desired 
playback. 

 

 

 

Show 
Alarm Log 
 
 
 
Show 
Snapshot Log
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Clicking on the History Source-Data File button opens the History Data window (previous figure).   

The default is the entire history file.  To change the start and end dates drag the sliders to the desired start 
and stop times.  Click OK.  Then, from the plot window, click the play button to play back the file.  

 

Historical Data is not available via Networking remote access. 

 
The History Data window includes a Show Alarm Log button.  Click the button to open a table of alarm 
events that are included in the file (if applicable).  You can select an alarm event to display the data that 
surrounds the event. 
 
The History Data window also includes a Show Snapshot Log button.  Click the button to open a list of 
data snapshots.  You can select a snapshot from the list to view it in the plot window. 
 

RPM Overlap -  RPM Overlap, also referred to as Overlapped Data and Consecutive Data Blocking, is 
used to analyze data from large machine transients.  It creates better resolution for rapid machine 
acceleration rates (>100 rpm/sec).  When the RPM Overlap checkbox is checked, eZ-TOMAS overlaps the 
second part of a block of data with the first part of the next block of data.  This results in a new block of 
data with an increased number of data points.  When the overlapped data is displayed in a plot, the 
resolution is increased for better analysis.  Complete the following steps to run RPM Overlap: 

1. Check the History Data windows RPM Overlap checkbox. 
2. Use the slide bars to select the start and ending times that are to be included in the overlap 

process. 
3. Display this data later by selecting Overlap as the data source in the Plots window. 

 

RPM Filter – This feature eliminates hysterisis and is therefore useful for trend displays, e.g., Stripchart, 
Polar, Shaft Centerline and Bode.  If the RPM Filter checkbox is checked eZ-TOMAS will only display 
data for increasing or decreasing RPM.   

 

Playback provides a means of playing back historical data files with the following controls: 

Playback Buttons and File Slider for Historical Data 

In order from left to right they are: 

Rewind 
Step backward one record 
Stop 
Play 
Step forward one record 

Note that you can drag the slider (at the right of the play buttons) to a specific area of the file before you 
start playing back the data. 
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eZ-TOMAS, Plot Control Buttons in 3 Toolbars 

 

1st Toolbar 

 

 

1 
 

Data Source-Real Time – selects the “Real Time” live data acquisition mode or the “History Data” (Play Back) mode.  

2 
 

Pause / Continue – toggles to pause or continue data monitoring.   Applies only to the Real Time mode. 

3 

 

Data Source-History File – Opens the History Data Dialog Box to select a file for viewing via the playback (history 
data) mode.  After clicking this button the playback buttons and related slider will appear as indicated on page 6-3. 

5 
 

Add Plot Window – Adds one more plot window to the screen.  Note that there is a limit of 8 plot windows. 

6 
 

Align Plots, Vertical Orientation – Affective with 2 or more plots.  This function orients the plot windows such that 
they are longer in the vertical direction.  With 8 plot windows, eZ-TOMAS will display 2 rows of 4 plot windows.  
Compare this feature to the following “Align Plots, Horizontal Orientation.” 

7 
 

Align Plots, Horizontal Orientation – Affective with 2 or more plots.  This function orients the plot windows such that 
they are longer in the horizontal direction.  With 8 plot windows, eZ-TOMAS will display 4 rows of 2 plot windows.  
Compare this preceding “Align Plots, Vertical Orientation.” 

 

6

2nd Toolbar
8 
 

Time Waveform - Selects Plot Display window for which the x-axis is in units of time. 

9 
 

Spectrum –  Selects a Plot Display window for which the x-axis is in frequency-related units. 

10 

 

Orbit – Used to plot a time waveform for a channel pair.  The data will is displayed in a polar format. 

11 
 

Waterfall – Selects a Plot Display window that makes use of x, y, and z axis.  Waterfall plots display data as a series 
of Spectral Maps.  Some users refer to Waterfall Plots as Cascades. 

12 
 

Bode – Selects a plot display window in which the x-axis is scaled in RPM. 

13 
 

Polar – Selects a window for a circular plot with units of g’s/division. 

14 
 

Stripchart – Selects a stripchart type plot display window. 

15 
 

Shaft Centerline – Used to plot a shaft centerline orbit as a trend in Gap Voltage for a channel pair.  The data is 
displayed in a polar format. 

16  Tachometer Reference – Choosing a channel number sets the tachometer reference channel to be displayed, 
regardless of the Setup Configuration settings.  If only one channel is displayed the “T” option is available.  “T” assigns 
the reference tachometer in accordance with Setup Configuration. 

17 
 

Show Baseline – superimposes a pre-recorded baseline on top of display data. This option is only available in the 
Time or Spectrum plots.   Show Baseline is typically used to compare a spectrum with another (the baseline) which 
was taken when the machine was known to be in good working condition.  Show baseline is only available for multiple 
plot applications. 
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3rd Toolbar 

 
Scale – Toggles between Instrument Scale, Auto Scale, and User Scale.  

 

 
Instrum

ent 
Scale 

Instrument Scale is the default.  It displays the data based on the instrument’s Engineering Units range. 

 
 

Auto 
Scale 

Auto Scale automatically scales the axes based on the data being displayed. 

18 

  
User 
Scale 

User Scale is used to display data in relation to a user-defined scale.  You can quickly customize a scale as 
follows: 

(1) press the <Ctrl> + <Alt> keys and hold them in. 
(2) press the <left mouse button> and hold in 
(3) move the mouse cursor to draw a rectangle around the area of the plot that you desire to view.  
(4) release the mouse button and the two keys.  Your plot should now have a new and more practical 
scale. 

19 
 

Linear / Log Scale Y Axis – Spectrum Display Only.  This button allows you to switch between Linear and Log Y-axis 
scaling.  If you expand the data plot this feature is disabled until the plot is returned to its original scale via the Auto 
Scale button.  

 
Frequency Axis – Used to set the x-axis to Hz, kCPM, or Orders.   Applies to Spectrum Plot Windows only.   Each 
click of the Frequency Axis button toggles the x-axis unit of measure, i.e., Hz, kCPM, Orders, Hz, kCPM, Orders, etc. 

20 

  
  

Hz 
 

Kcpm 
 

Orders 

 
 

21 
 

Multiple Trace Cursor 
Locked  - When locked, a single cursor will maintain a reference mark for each trace in the plot window, i.e, at each 
point where the cursor intersects a waveform. 
Unlocked - When unlocked, there will only be one reference mark on the cursor.  The mark will only apply to the first 
trace (lowest number channel).  However, a separate cursor can be used for each trace. 

22 
 

Display Cursor Values – Brings up an information box which includes time, rpm, and x and y axis values for each 
cursor [for the point in which it intersects its associated waveform].  

23 
 

Display Gage Values – opens a floating table of gauge values.  Alternatively, it allows cursor values to be displayed, 
if the Display Cursor Values button is activated.  (see Display Cursor Values).  Note that the “L” key on the keyboard 
can be used to display the gauge values. 

24 
 

 

Cursor Update - Fixed X axis / Peak Search – When this button has a gray background, the x-axis is fixed and the 
cursor will not move when a new spectrum is plotted.  When the button has a green background “Peak Search” is in 
effect and the cursor will automatically move to the highest point on the plot.  The button is typically used for Spectrum 
plots, either Real Time or Historical Data.  

25 
 

Cursor Mode – Only available for Spectrum plot displays.  The button cycles through the following four modes. 

 
Normal (gauge values) – A free-moving single cursor provides a point for each trace displayed.  This is the 
only cursor that can be used with multiple traces. 

 
Harmonic – Can only be used when 1 trace is displayed.  Results in several cursors positioned to the right of 
the primary cursor and at intervals that are at twice the x-axis value of the primary cursor.  For example:  
When the primary cursor is at 100 Hz, the first harmonic cursor will be at 200 Hz, the second at 400 Hz, the 
third at 600 Hz, etc.  Moving the primary cursor to 400 Hz would result in the first harmonic cursor residing at 
800 Hz, the second at 1200 Hz, etc.   If Display Gauge Values is selected, the applicable values will be 
shown for all cursors.  Harmonic cursors can only be moved by moving the primary cursor. 

 
Side Band – Can only be used when 1 trace is displayed.  Results in several cursors spaced at even 
intervals on both sides of the primary cursor.  Unlike the harmonic cursors, the sideband cursors can be 
moved by the user.  Once adjusted, they remain in position at until the next adjustment.  If Display Gauge 
Values is selected, the applicable values will be shown for all cursors. 

  

 
Peak List – Can only be used when 1 trace is displayed.  On a real-time or playing plot, the cursor will 
automatically position itself at the highest point on the trace. 
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3rd Toolbar (continued) 

26 
 

Annotation - Active with Polar, Waterfall, and Shaft Centerline Plots.  Use this button to superimpose RPM or Time 
values onto the displayed data. 

27 
 

Overlay Limits – For Spectrum, Stripchart, and Polar plot windows.   Superimposes the limit values onto the 
displayed data. 

28 
 

Runout Compensation – displays a graph of the RunOut compensated values. RunOut compensation is a vector 
math operation in which the referenced first-order amplitude and phase vector is subtracted from the displayed first 
order vector.  This option is only available for Bode and Polar plots. 

29 
 

Overlay Bearing Clearance Circle – Used with Orbit and Shaft Centerline plots.  Superimposes the bearing 
clearance circle over the plot display. 

30  Band Pass Filter Selection –  Used with Time and Orbit plots.  Allows the user to apply an nX filter to time data for 
Time and Orbit plot displays.  

31 
 

Shaft Revolution Filter –  Used with Time and Orbit plots.  This filter selection is used to limit the amount of data 
displayed.  The limitation is set by selecting “n,” where “n” is equal to the number of shaft revolutions.  The Shaft 
Revolution Filter is used to make the plot display cleaner by reducing clutter from excess data. 

 

Channels  
The vertical channel bar at the right-hand edge of the screen represents 8 input channels.  The number of 
channels that can be displayed is dependent on the plot display format.  Some points regarding channels 
follow.  

A color-filled channel box indicates that the channel is currently being displayed as a trace of 
matching color. 

• 

• 

• 

• 

• 

• 

• 

A white channel box indicates that the channel is active, but is not being displayed. 

A dimmed channel number is not active, thus there is no data to display. 

Multiple channels can be plotted on Time, Spectrum, Strip Chart, and Bode displays. 

A single channel can be plotted on Waterfall, Polar , and Shaft Center Line displays. 

For Orbit displays, the time display of a channel pair and tach pulse location are displayed. 

Channel boxes for Tach channels appear in the row below the menu bar. 

 
Four Plots Displayed Simultaneously 
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Filtering Data 
 

Time and Orbit plot displays can be cleaned up by the use of band and/or shaft revolution filters.  The two 

iltered data.  The plot on the 

filter pull-down lists reside just to the right of the buttons in the third toolbar [when counting the main 
window toolbar as toolbar 1].  The first filter list allows the user to select a Band Filter.  The second filter 
list allows the user to filter data based on the number of shaft revolutions. 

In the example below, the plot on the left is based on 10 revolutions of unf
right makes use of the same data from 10 revolutions, but also makes use of a 1x filter. 

 

 
Band Filter 
Selections 

Shaft Revolution 
Filter Selections 

No Filter 

1x 

2x 

3x 

4x 

5x 

6x 

Full Block 

1 Rev 

2 Revs 

 

5 Revs 

10 Revs

 

 

 

 

 

 

 

 

 

 

 

No Filter                     10 Revs  vs 1x Filter            10 Re

Plots Showing the Same Data with Different Band Filter Selections 
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Examples of Displays 

Time Displays 
Time Displays show vibration amplitude as a function of either time or rotation for a block  
of time data.  The default X axis is time “Full Block.”  If the rotating speed is greater than 0 RPM, the X 
axis can be specified as “N” Shaft Revolutions.  Where “N”  is 1, 2, 5, or 10.  One shaft revolution equals 
360 degrees of rotation. 

 

Multiple channels can be shown on the Time Display.    

 

 

Time 
Display 

Time Display Plot of Two Channels 

 

 



Spectrum Displays   
Spectrum Displays show vibration amplitude as a function of frequency.  The frequency  

s can be either Hertz (Hz), cycles per minute (kCPM) or orders.    

M

 

unit

 
ultiple channels can be shown on the Spectrum Display. 

 

Spectrum Display of Two Channels 

Spectrum 
Display 
 
 
Display 

rsor 
lues 

Cu
Va
 
 
Display 
Gage 
Values 
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Orbit Displays 
 

Orbit Displays show simultaneous time domain vibration amplitude for an X and Y probe pair.   

tes the direction of the time signal, which in 
e data.  However, a specific number of 

haft Revolutions can be displayed (1, 2, 5, or 10) by using the associated pull-down list (see figure).  The 
orbit display is corrected for probe location. 

You can optionally overlay the orbit onto a shaft center line display by clicking the Shaft Centerline 
button. The center of the orbit trace in SCL computes the difference between the current gap voltage and 
the reference gap voltage.  Information regarding shaft centerline plots is presented on page 6-17. 

To display an overlay of the bearing circle clearance, as indicated below, click the associated button  
(see figure). 

Note:  Only one probe pair can be shown on the Orbit Display.     

 

The red arrow displays the tach reference marker and indica
this example is CCW.  The default display is “Full Block” of tim
S

 

Shaft Revolutions Filter 
You can use the Shaft Revolution 
Filter pull-down list to limit the amount 
of data displayed to 1, 2, 5, or 10 
revolutions.  The default setting is “Full 
Block.” 

Overlay Bearing Clearance Circle 
(Selected in this example) 

Shaft Centerline (see pg. 6-18) 

 
 

 
 

Or
Display 

bit 

Orbit with Bearing Circle 
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Waterfall Displays 
 

Waterfall Displays, show rpm data in simulated 3D by means of X, Y, and Z axes.     

 

 

eZ-TOM
Waterfall 
Display 

elect Sp
 
S
Band Typ
(1 throug
 
 
Annotation 
(is “On”) 

ectral 
es 
h 10) 
 

Waterfall Display 

 

The ten Spectral Band Types are: (1) Overall,  (2) DC Gap V,  (3)1x A  
four bands pre-determined; and  spectral bands (5) through (10) being er defined.  In the above plot 
display, Spectral Band types [1], [3], and [7] have been selected. 

mplitude,  (4) 1x Phase with these
us
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Bode Displays 
Bode Displays show vibration amplitude and phase as a function of rotating speed.  The  

unout 

 
Runout Compensation is a vector math operation, in which the referenced first order amplitude and phase 
vector is subtracted from the displayed first order vector. 

Note:  Bode displays can only be used when one channel is selected.     

 

litude, selected                     1xPhase selected 
ia button [3]  via button [4] 

 

lower trace display is the first order amplitude values.  You can optionally display the R
compensation values on the same plot by clicking the associated button. 

 

1x Amp
     v  

 

 
 
Bode 
Display
 
Display
Cursor 
Values 
 
 
 
Runout 
Compensation 

 

 1x Phase 

1x Amplitude 

Bode Display 
1x Amplitude and Phase vs. RPM for Channel 1 

 

In the above figure: 

• 1xAmplitude is from button [3] in the center toolbar 

• 1xPhase is from button [4] 

• To get Runout Compensation, press the associate button (see figure) 
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r Displa
ected for 

ptionally display the “Runout” 

d first order amplitude and phase 
ector is subtracted from the displayed first order vector. 

ote:  Only one channel can be shown on a Polar Display.     

ys Pola
Polar Displays show vibration amplitude and phase lag on a polar plot format. The data is corr

robe location.  Phase lag is opposite the direction of rotation.  You can op
compensated values by clicking the associated button (see figure). The compensation values are specified 
for each channel in the setup configuration.  
 
Runout Compensation is a vector math operation, in which the reference
v
 
N

 

 

Polar Display with Annotation 

 

 

Runout 
Compensation 
 
 
Annotation 
 
 
Polar Display 
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Strip Chart Displays 

he spectral bands are selected from numbered buttons located in the central toolbar (see figure). 

 

 

 

Strip Chart Displays, show selected instrument gauge values as a function of date and time.   
The ten Spectral Band Types are: (1) Overall, (2) DC Gap V,  (3)1x Amplitude,  (4) 1x Phase, 
with these four bands pre-determined; and  spectral bands (5) through (10) being user defined. 
 
T
 
 

 

 

Stripchart
Display 
 
Select Spectral 
Band Type 
(1 through 10) 

 

Strip C
In this example, 3 spectral bands [1], [3], and [7] have been selected. 

 

hart Display for Channel 1 



Shaft Center Line (SCL) 
haft Centerline (SCL) is used to display the change in gap voltage for a Channel Pair.  SCL is typically S

used in conjunction with Displacement Probes.   

 
 

 
 
 

In order to get valid SCL displays the input channels must be DC coupled.  

The measured DC Gap Voltage is corrected to the Gap Reference Value and Shaft Starting Location  
(Brg Sta ), which are set in the Edit pull-down menu’s Setup Configuration window, in the Input 
Channels tab. 

 

 

 

rt

Curso
Values 

r 

Shaft Centerline Display with

 

The movement of the shaft centerline [towards the probe]
in Gap Voltage by the Displacement Probe’s sensitivity.  

Example:  

Machine running:  Gap Voltage (GV1) is -9 VDC
Machine at rest: Gap Reference Voltage (GV2) is
Delta Gap Voltage: (GV1 – GV2) is 1 VDC 
Probe Sensitivity (S): 200 mV/mil 
 
SCL movement equals Delta Gap Voltage divide
 
Movement = (GV1 – GV2) / S 

= 1VDC / (200 mV/mil)  
= 5 mil 
 
Note: 1 mil = 0.001 inch, or 25.4 µm
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Shaft Centerline Display 
 
 
Annotation 
 
 Annotation 

 can be easily calculated by dividing the change 
An example follows.   

 
 -10 VDC 

d by Probe Sensitivity, therefore: 
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Reports Menu 7 
 
Statistical Report …… 7-1
Alarm Log Report …… 7-4 
Snapshot Log …… 7-5 
Configuration Setup [.txt File] …… 7-5 

 

 

eZ-TOMAS can generate the following types of reports: Statistical Report, Snapshot Log, Alarm Log, and 
a Configuration Setup text file (.txt). 

 

Statistical Report 
The Statistical Report lists the historical spectral band data.  It includes the instrument, the engineering 
units, the minimum value, the mean average value, the maximum value, and the standard deviation by 
channel.   

The Statistical Report can be accessed from the Gauge Window’s Reports Pull-down menu. 

 

Statistical Report 

 

The report can be saved as an ASCII text file for further use. 

This data can be used to generate or fine tune limits.  Note that you can have eZ-TOMAS automatically 
compute limit values by selecting Generate Limits on the File menu.  You can view and modify limits by 
selecting Limits in the Gauge Window’s Edit pull-down menu.  Chapter 2 contains additional information. 
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Accessing a Statistical Report 
To obtain a Statistical Report you need to specify the time period that the report is to cover.  This is 
accomplished as follows: 

1. From the Gauge Window’s Reports pull-down menu, select Statistical.  The History Data window 
will open (see following figure). 

 

History Data Window 

2. Drag the pointers across the slide scales to select the Start Date/Time, and the End Date/Time, which 
is to define the period of time that the report is to cover.   

3. Click the <OK> button to display the report. 

4. To save the Statistical Report as an ASCII text file, select Save the Report from the Statistical 
Report’s File pull-down menu (see following figure). 

 

 
The Statistical Report’s File Pull-down Menu 

With options to “Save the Report” and to “Generate Limits” 

 

Statistical reports can be used to automatically generate limit values based on historical data.  If your 
monitored machine has been operating at a steady state condition and if you have stored data at this 
condition, then eZ-TOMAS can use this data to determine limit values based on the average and variance 
of the data.  However, you probably will want to edit these limits if the machine is experiencing amplitude 
or frequency shifts. 
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Using a Statistical Report to Generate Limits 
Statistical reports can be used to automatically generate limit values based on history data. If you have 
acquired and stored data at a steady state machine condition Tomas can calculate limits for you based on 
the Average and Variance of the data. 

1. On the Reports pull-down menu select Statistical; the History Data window will open. 

2. Drag the top slide pointer across the time scale to select the Start Date and Time for the report. 

3. Drag the lower slide pointer across the time scale to select the End Date and Time for the report. 

4. Click the <OK> button.  The Statistical Report will be displayed. 

5. Open the File pull-down menu. 

6. Select “Generate Limits.”  The Limit Generation dialog box will appear (see following figure). 

7. Select the Spectral Bands for which limits should be generated. 
 

 

Limit values are not used if: 
(a)  the 'HiHi limit value' minus the 'LoLo limit value' is less than 5% of the 

instrument scale, or 
(b)  the limit value is outside of the instrument range. 

 
 

 

Limit Generation 

 
 

8. In the Limit Value Calculation panel, specify the Standard Deviation to be used for Alert High, 
Alert Low, and Danger High, Danger Low. 

9. Click the <OK> button.  A prompt will appear, asking if you want to Save New Limits. 
 

10. Click <Yes>. 
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Alarm Log 
The Alarm Log contains the last “N” number of alarms.  The number of alarms was specified in the Setup 
Configuration window under the Storage Tab.  The Alarm Log (following figure) includes the date and 
time, the channel number, reference tachometer, instrument name, spectral band type, alarm type, and value 
of the alarm signal.  

You can access the Alarm Log from the Gauge Window’s Reports pull-down menu, or by clicking the 
<Show Alarm Log> button [located in the History Data File window]. 

Alarm Log 

 

To save this report, select Save the Report on the File Menu at the top of this window.  The Alarm log is 
saved to a TXT file associated with the Tomas project.  Notepad is automatically activated to show the 
Alarm log. 

To display data surrounding the alarm event, Double Click on the alarm event.   

To export this data to an ASCII file, select Backup/Export on the File menu in the Main window. 

The Show Alarm Log Button in the History Data Window 
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Snapshot Log 

 

 
 
 
 
 
 
 

<Snapshot Button>  
on the Gauge Window 

 
This button is used to take a  
snapshot of 1 frame of data. 

<Show Snapshot Log> Button & Show Snapshot Log 
This button is used to access the Snapshot Log. 

 

The Snapshot Log can be accessed from the Gauge Window’s Reports pull-down menu, or from the 
History Data Window.  The Snapshot Log file contains entries which were created whenever the user 
clicked the <Snapshot> button, which is located in the Gauge Window’s Data Storage panel (see upper left 
figure).  That button should not be confused with the <Show Snapshot Log> button, which is located in 
the History Data Window. 

The <Snapshot> button captures one frame of data which is stored in the log.  In the above figure the log 
contains 2 entries 

 

Configuration Setup   [.txt File] 
Selecting “Configuration Setup” from the Reports pull-down menu creates a text file that contains 
configuration details of the current project. 

Setup Configuration .txt File 
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Security Menu  8 
 

 

 

Security Pull-Down Menu 

 

eZ-TOMAS has 3 Security Levels.   

•     User Level 1 has very limited privileges – Exit, Print, Generate Alarm Log Report, and View 
Gauge data in the Main menu. 

• UUser Level 2 has a few limitations.  Level 2 operators cannot start a new project, erase the History 
file, or change the security password. 

•     User Level 3 has full privileges, which include the ability to start new projects and erase History 
files.  Level 3 is password protected. 

 

After selecting User Level 3, a dialogue box similar to the following will appear.  The user must enter the 
project’s Level 3 password to enable full privileges. 

 

 

 

 

 

 

 

 Security Level 3 Dialog Box
 

 

 

No password is required to go from Level 3 down to Level 2 or to Level 1.  However, the project password 
is required to move from Level 1, or Level 2, to a higher level.
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The “Change Password” command, in the Security pull-down menu, opens the Change Project Password 
dialog box (see following figure).  This dialog box will only be visible when the user selects the “Change 
Password.” option.  Note that you can only access the Change Project Password box from User Level 3.  

 

 
Changing the Project Password 

 

To change the password: 

1. Open the Security pull-down menu. 

2. Select “Change Password.”  Note that you can only do this from User Level 3. 
The Change Project Password dialog box will open. 

3. Type the desired password in the field below “Enter Level 3 Password.” 

4. Re-enter the password in the “confirm” text box. 

5. Press the <OK> button.   

 

If the confirmed password was entered correctly the new password will be in effect. 

 

 

8-2 897796 eZ-TOMAS, Security Menu  



eZ-TOMAS User's Manual 897696 A-1 

Appendix A       Using Function Keys A 
 

tomasfkeys..ini 
The tomasfkeys.ini file, distributed with eZ-TOMAS software, makes it possible to use your keyboard’s 
Function Keys (F1 through F12) in conjunction with eZ-TOMAS.  Through the ini file, you can set the 
Function Keys to open frequently used projects. 

The task of each Function Key is determined by how it is defined in the tomasfkeys.ini file.  The following 
table includes several definitions.  In every case the first 4 characters are Fnn=, where the letters “n” 
identify the Function Key of interest, e.g., F01 represents the F1 key, F02 the F2 key, etc.  Each function 
setup must start with the Fnn= syntax. 

 

Example of Function Key Application 
Key Function Setup in tomasfkeys.ini Function 

F1 F01=HELP Accesses the Help file 

F2 F02=ACQ  Turn the Acquisition On or Off 

F3 F03=LC  Turns the Limit Check On or Off 

F4 F04=SAVE The same as clicking the <Snap Shot> button [camera 
image] on eZ-TOMAS’s main window.  Causes the 
current record to be saved and stored into the History File.  
An Acquisition must be running in order to use this 
function. 

F5 F05=       

F6 F06=        

F7 F07=        

F8 F08=        

 

See Customization,  
page A-2 

Function Keys can be set to open a specified project. For 
example, the following 

F05=c:\program files\data\motor.tom1 

sets F5 to open a motor project (motor.tom1) via the 
path: c:\program files\data 

 

F9 F09=PRINT Opens the Print window 

F10 F10=          See Customization,  
page A-2 

-- 

F11 F11=SN Selects the serial number text field, which is located in the 
Machine Description section of eZ-TOMAS’s main 
window. 

F12 F12=  See Customization,  
page A-2 

-- 
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Customization 

You can customize the Function Keys for eZ-TOMAS by completing the following steps: 

1. Open the tomasfkeys.ini file in the Notepad application, or in a similar text editor.  Note that 
if you double-click on the ini file it will automatically open in Notepad, providing you have 
that application.  

2. Type new Function Key definitions, or edit the ones you want to change.  
For example, for the F5 key, a user might enter: F05=d:\program files\data\turbine.tom3 
where d:\program files\data is the path and turbine.tom3 is the file.  

3. After you have made the desired changes, save the edited tomasfkeys.ini file. 

Note:   If eZ-TOMAS is running, you will need to close the program and restart it before the 
changes go into effect. 
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Appendix B               Relationship of Terms B 
 

The following terms are interrelated and should be understood by users of eZ-TOMAS. 

 

Array Two or more samples of data. 

Blocksize The number of data samples that are used in the FFT (Fast Fourier Transform) 
process.  Blocksize has the same meaning as Data Block array size. 

Data Block An array of data samples that are used in the FFT (Fast Fourier Transform) process.
The Data Block’s array size is the same as its Blocksize.  Data Block is also 
referred to as “Time Data Block.” 

FFT Fast Fourier Transform.  An efficient technique for calculating the frequency of 
components in a time-domain waveform based on digitized voltage measurements.  
The result is a display of amplitude versus frequency and phase versus frequency. 

Sampling Rate A rate that is 2.56 times the Analysis Frequency.   

Spectral 
Resolution 

A value related to Analysis Frequency (f) and Blocksize (b).  Where  
Spectral Resolution = f divided by b divided by 2.56. 

Time Data Block See Data Block. 

  

Example of Interrelated Terms, Mathematically Expressed 

Given: 
Analysis Frequency (f) = 1000 Hz 
Blocksize (b) = 2048 

Calculated: 

Sampling Rate = 2560 sample per second.  Derived from 1000 x 2.56.  
       This rate applies to each channel. 

Time Data Block = 2048.  This is because Data Block equals Blocksize, which was 
       given as 2048. 

Spectral Data Block = 800.  This is the Block Size divided by 2.56. 
Thus, 2048 divided by 2.56. 

 
Spectral Resolution = 1.25 Hz per spectral line.   This is derived as follows: 

f divided by b divided by 2.56 
1000 Hz / 2048 / 2.56 = 1.25 Hz 
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